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Uzivatelska cast Office 2010

Micresoft:
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Spolecné nove vlastnosti

Na dokumentech lIze pracovat v PC, v telefonu a browseru
K dispozici 32bitova i 64bitova verze
Ukladani dokumentl na web pro spolecnou praci a sdileni

Jednodussi Pas karet, napric vsemi aplikacemi Microsoft
Office, ale i ve Windows 7 a serveru SharePoint

Prehledné dialogové okno Backstage™ pro nastroje
otvirani, ukladani, tisk, sdileni, publikovani dokumentu.

Galerie pro vkladani obsahu zkopirovaneho do schranky
Bohatsi galerie SmartArt
Novée moznosti editace grafiky - obrazku, fotografii a videa



Top Ten Word 2010

B OY LN B LW

Vsechny vyskyty hledaného slova v dokumentu v
prehledném okne s vysledky vyhledavani

Nove vizualni efekty textu — stin, sklon, zare odraz
Fotoeditacni nastroje pro upravu vlozenych fotografii
Obnovi soubor omylem zavreny pred ulozenim

Novy korektor pravopisu a strojove preklady
Soubézna uprava dokumentu vice autory

Ukladani dokumentu na web, Ize pak sdilet, upravovat
odkudkoliv pomoci Word Web App nebo Word Mobile

Bohatsi galerie diagramu SmartArt

Vkladani snimku obrazovky do dokumentu jednim
kliknutim

10.Dialog Backstage™ a zdokonaleny Pas karet, ktery Ize

prizpusobovat



Ukazky Word 20
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very excited about this design and think that visitors to your garden come awa . o 5
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Backstage™

Documentl - Microsoft Word

Home Insert Page Layout References Mailings Review View Developer

e
Save & Send Send Using E-mail

[l save As

[ Open

[ﬂ: .] Send Using E-mail _ Attach a copy oftms document to a.n e—ma|.l
- u Everyone receives separate copies of this document

3 Close s Changes and feedback need to be incerporated manually
@ save to Web Attachment

Save to SharePoint Create an e-mail that contains a link to this document

Everyone works on the same copy of this document

Info

Recent

MNew @ Publish as Blog Post Everyone always sees the latest changes
Keeps the e-mail size small

File Types /1y Document must be saved in a shared location

H Change File Type Attach a PDF copy of this document to an e-mail
Docurnent locks the same on most computers

Help Preserves fonts, formatting, and images

J Create PDF/XPS Document

Content cannot be easily changed
] Options

& e Attach a XPS copy of this document to an e-mail
®ps Document locks the same on most computers
Preserves fonts, formatting, and images
Send as XP5 Content cannot be easily changed

Send as Internet Fax
IE) Send a fax without using a fax machine

W . - -
Requires a fax service provider
Send as

Internet Fax




Top Ten Excel 2010

. .Krivky” — minigrafy uvnitr kazde bunky
. .Prurezy” — jednodussi ovladani filtrd kontingencni tabulky
. Zdokonalené podminéne formatovani — jednodussi

nastaveni vizualizace, zobrazeni negativnich hodnot

. Zobrazeni kontigencnich grafl nezavislé na zobrazeni

kontingencni tabulky

. Doplnek PowerPivot pro analyzu rozsahlych mnozin dat

1
2
3
4
5
6.
£
8
0.
1

64bitova verze Excelu rychleji zpracuje rozsahle sesity

. Publikace ,zivych” sesitu Excel na SharePoint
. Ukladani sesitu na web, Ize jej pak sdilet, upravovat

odkudkoliv pomoci Excel Web App nebo Excel Mobile
Soubézna Uprava sesitu vice autory

0.Dialog Backstage™ a zdokonaleny Pas karet, ktery Ize

prizpusobovat
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Top Ten PowerPoint 2010

. Grafické upravy fotografii a obrazku na Urovni fotoeditoru
. Bohaté moznosti editace a formatovani vlozeného videa

. Prezentovani v realném case na internetu

. Galerie ,televiznich” prechodu mezi snimky a zdokonalené

animace

. Clenéni snimku prezentace do sekci

1
2
3
4
5
6.
=
8
Q.
1

Kazda prezentace se otevira do samostatného okna

. Soubézna uprava prezentace vice autory
. Ukladani prezentace na web, Ize pak sdilet, upravovat

odkudkoliv v PowerPoint Web App a PowerPoint Mobile
Bohatsi galerie diagramu SmartArt

0.Dialog Backstage™ a zdokonaleny Péas karet, ktery Ize

prizpusobovat



Ukazky PowerPoint 2010
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Top Ten Outlook 2010

Sprava zprav z ruznych e-mailovych uctu (Exchange
Seznam, Hotmail, Gmail) na jednom miste

. Konverzacni zobrazeni zkondenzuje stovky zprav na

nekolik konverzaci. Pouzijte pak ,Vycistit” nebo ,Ignorovat”

. Vami nadefinované ,Rychlé kroky” provedou postupne

kroky naraz napt. ,Odpovedet svolanim schuzky”

. .Zobrazeni pro planovani” zobrazi kalendare ucastniku

schuzky pod sebou

. Novy vyhledavaci nastroj pro zpravy, kalendar a kontakty

1.
2
3
4
5
6.
7
8
o)
1

Editor zprav obsahuje SmartArt, motivy a formatovani
grafiky

. Outlook Social Connector sbira informace o pratelich
. Funkce Nez odeslete ..

Faxy a hlasové zpravy do vasi postovni schranky*

0.Integrovany instant messaging — Office Communicator



Ukazky Outlook 2010
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Ukazky Outlook 2010
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Top Ten OneNote 2010

©ENO U1 & WN

. Poznamky z prohllzenl webovych stranek/dokumentu se
automaticky opatri odkazy na ne

Novy navigacni panel pro rychlou orientaci pozn. bloky
Rychlé ukladani poznamek — vyberete jen poznamkovy
blok, kam se maji ukladat

Pri Uprave riznymi autory se zvyrazni zmeny od
posledniho otevreni a je k dispozici historie verzi

Zdokonalené vyhledavani, bere v uvahu i posledni vami
vybrana mista a stranky

Nove textové styly a nastroj Kopirovat format
Wiki odkazy propoji poznamky roztrousené po bloku
Ponechate kurzor nad slovem a zobrazi se jeho preklad

Ukladani poznamek na web, Ize je pak sdilet, upravovat
odkudkoliv ve OneNote Web App a OneNote Mobile

10.Dialog Backstage™ a Pas karet, ktery Ize ptizplsobovat



Ukazky OneNote 2010
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Novinky Visio 2010

Ribbon

Nova zobrazeni diagramu, celkem vice nez 60!

Visio Services

Propracované propojeni a sdileni s ostatnimi
aplikacemi a uzivateli



Visio 2010: snadnégjsi navrh diagramu
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VISIOF'SENICES!

Visio Services o
Integrace Visia s SharePoint 2010

Publikace Visio diagramu na Uzivatel pozaduje obnovu dat
SharePoint Server 2010 Server vrati PNG nebo XAML

=<
Uzivatel

UzZivatel muze prohlizet a obnovovat
data v internetovém prohlizeci

[ERRPRERER  ont o -
=

SIA)
Tvurce

Vytvoreni diagramu napojeného na Databaze
data



Microsoft Office Mobile 2010

Word, Excel, PowerPoint, OneNote, Outlook,
SharePoint Workspace

Automaticka synchronizace se serverem — Outlook (emaily,
kalendar, ukoly), SharePoint Workspace (dokumenty...)

&% Excel Mobile 1 & 7-:'“ i &S @ A ActiveSync 1 q':."i-:.“ i & X
Al - Exchange Server
| A | B | Connected

.'.. Outlook E-mail ,".',’ Vo 4 X V'da'e
e
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e essssonosncue I e | S0
o s | 1700
efsec s | 3100
o freiion | 200
& Jotchod s | 300
| 9 [Hypotéka | 10 000]

masinka
Synchronized: 27.5.10 9:10

v-jirika-PC

Connected

&l Location? Amnesiacs Anon... |/ -/0Y

1a) ¥

@ Sales Meetihg, New York?
Adam Jung

{1 Contoso Biz. Plan Proposal »
© JimLucey

{ Voice Mail from Brandon H... 1/29/09
Brandon Hoff (EXCHANGE)
Adam can you meet at 130,

Outlook E-mail 22 Items, 21 Unread.

Delete B Menu

Connected

View Menu



Office Web Apps

Office Web Apps jsou internetovym rozsirenim Microsoft Office

Spolecna prace
Prace kdekoliv P P

Tigers Funds Rais¢
igers
Season

v Funds Raised
i

Highlights
2009

* Prace na libovolném zarizeni - PC, - Bezpeéné sdileni - snadné sdileni
smartphone nebo internetovy prohlizec dokumentd - mozZnost souc¢asného prohlizeni
- 100% vérné zobrazeni - prohlizeni a Qprav vice Ii.dmi naraz; pritom neni treba mit
dokumentd s vérnym zobrazenim Microsoft Office.
zformatovani * Prace na nékolika platformach - v
prohlizecich IE, Firefox, and Safari on PC, Mac,
or Linux!

Rozsireni Microsoft Office

Save & Send

Znamé prostiedi Office - neni treba se ucit
novou aplikaci

Shodné pouzivani na PC, v telefonu, v
prohlizeci; jste-li v prohlizeci, pak jednim
klikem pokracujete v Upravach dokumentu
na vasem PC?

Pfi praci v Office 2010 - mizete ukladat
dokumenty pfimo na web



Srovnani Office 2010 a Office Web Apps

(" office 2010 Office Web Apps

Tabulky v Bez formdtovdni tabulek
P Gra Jen zobrazem
Vytvareni bl 7
a produktivita SmartArt Jen zobrazeni Word, edtt PPT
__-20!//?@/1! 7
Soucasna prace na dokumentu Word, PPT, OneNote Excel, OneNote
o 'y, :'zl/j
Pristup odkudkoliv X v

REST API (Excel) X v

Neobsahuje tplny prehled funkci

Sdileni a
pristup
odkudkoliv



Office Web Apps — moznost vybéru

Pro domacnosti Pro organizace
Ulozisté Windows Live SkyDrive SharePoint Online SharePoint 2010
Ay.tentlflkace Windows Live ID Spravované odd. IT Spravované odd. IT
uzivatele

il e Haips |l lisiesiz s Office Web Apps jsou licencované
Ceny Zdarma (s reklamou) multilicenci Office 2010 a vyzaduji multiliceFr)\F():i g)fﬁce 2010

SharePoint Online subscription



Serverova cast Office 2010

Micresoft:



Moznost volby: software + sluzby

MICROSOFT ON MICROSOFT MICROSOFT
PREMISES ONLINE SERVICES LIVE@EDU

Flexibilita a kontrola Agilnost a snizené naklady Studenti

Data a operacni Kvalitni sluzby i pro Sluzby pro moderni

sprava plné pod nejvetsi organizace akademicky zivot

kontrolou organizace Snizené naklady Zdarma = vyborna

Flexibilita a vyvoj Jednodussi IT sprava hodnota

vlastnich aplikaci Nejnovéjsi Zakladni sluzby
technologie navrzené pro
Hostovano vzdelavaci sektor
Microsoftem Hostovano

Microsoftem




Software + sluzby: produkty

MICROSOFT ON MICROSOFT MICROSOFT
PREMISES ONLINE SERVICES LIVE@EDU

Flexibilita a kontrola Agilnost a snizené naklady Studenti

Exchange Server Exchange Online Outlook Live
2010 SharePoint Online WL Messenger
SharePoint Server Office Skupiny lidi
2010 Communications Skydrive

Office Online Fotogalerie
Communications Office Live Meeting Office Web Apps
Server 2007 R2




Microsoft®

& SharePoint 2010

Micresoft:



Microsoft SharePoint 2010

Platforma pro podnikovou spolupraci a web
Ribbon UI
SharePoint Workspace
SharePoint Mobile

BUEIESS ComnEGly Seaes S — Office Client and Office Web App Integration
InfoPath Form Services Standards Support
External Lists
Workflow .
SharePoint Designer Sites
Visual Studio . I '
API Enhancements . o Tagging, Tag Cloud, Ratings
REST/ATOM/RSS Composites Communities Social BOOKIAAANG

Blogs and Wikis

My Sites

Activity Feeds
Microsoft® 4 >
: ‘ SharePoint: groflllses and Expertise
. rg Browser
PerformancePoint Services In5|ghts Content g

Excel Services
Chart Web Part

Visio Services .
Enterprise Content Types

Web Analytics
SQL Serve)i Integration Search Metadata and Navigation
PowerPivot Document Sets
Multi-stage Disposition
Social Relevance Audio and Video Content Types
Phonetic Search Remote Blob Storage
Navigation List Enhancements
FAST Integration

Enhanced Pipeline



Novinky SharePoint 2010

Propojeni Office 2010 a SharePoint 2010

Jednoduché sdileni pomoci zalozky BackStage

Off-line prace na on-line dokumentech

Moznost off-line prace na dokumentech, kterée jsou
ulozeny na SharePointu

Editace v realnem case
Vice uzivateli muze editovat dokument ve stejnem case



Propojte Office a SharePoint

Jednoducha publikace na SharePoint pres BackStage

References

Send Using E-mail

Save to SkyDrive
Info

Recent Save to SharePoint

Publish as Blog Po

New @

Print

Help

File Types

H Change File Type

) PS Document
1] Options

k£ exit

Site Actions - Browse

Z Shared Documents

Documentl [Compatibility Mode] - Microsoft Word

Mailings Review View

Save to SharePoint

vailable when this

Additional collaboration features may

ith multiple people at the same time
Use a Web browser to view and edit documents
Send a link instead of an attachment
Retrieve previous versions of documents
Receive e-mail notifications when documents change

Recent Locations

Shared Documents
http://demo2010a

Forms
ht a/RFP/Forms
My SharePoint Locations

Contoso - Shared Documents
http D

Browse for a location

cument is s

Library Tools

Custom Commands Library

All Documents

Current Page

-~ E-mail a Link

Alert Me

Edit Library

=4
o SharePoint Connectto
Office - = Settings
tHin



Novy vzhled!

Jednoduché prizpusobeni a navrh peknych stranek

2 Team Firef

Team Site - Home

GET CENTRAL+FARM+BOX ADMIN, REMOTE DESKTOP Gideon Bibliowicz -

steadions» it B OE e
- Y/

Team Site » He ’
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Pas karet v SharePoint

Modified

00:02/ 00:30

{=

 Site - Home - Mozilla Firefo

it View History Bookmarks Tools Help
- C o tp:// sharepoint/teamsite/SitePages/Home asp:)

Team Site - Home +

Editing Tools
= GET CENTRAL+FARM+BOX ADMIN, REMOTE DESKTOP Gideon Bibliowicz
siteacions» B = Browse Page [RTATEl
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Verdana
‘h J v = Select+

Save CheckOut  Paste B I Usexx WA 9
o . N Undo = 9 3 s HIML.

Clipboard Font Paragraph Styles  Spelling _Layout Markup
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diky AJAX , | py——

0%

Modified By O O 3

Pre-Beta screenshots, subject to change



SharePoint Workspace 2010

Upravujte dokumenty na
SharePoint, i kdyz jste off-line

Browse

wiew

Rating (0-5)

Content

Documents
__ Better Together
ity 5 Phone

10 Msin Strest  Redmond 4255551212
7 Drop Off Library = Redmond
. Form Templat
) Images

rketing Emails

Redmond
Redmond
Redmond

liection Documents
& Collection Images
yle Library

nounceme

CustomeriD 1

= Workflow Tasks FirstName Olivia
External Lists
Business Contacts as m Shone

10 Main Street

Redmond

WA

4255551212

Last synchro



Pracujte, i kdyz jste off-line

Ctéte a zapisujte na SharePoint a LOB systém( pomoci SharePoint Workspace

Synchronizace zmeén,
ne vsech soubord

Mew Product Incuba 5 1er Feedback - Micr
Warkspace View
Lis

All Ttems Mark Find

Pas karet a zalozka
Backstage

Titanium

Gontoso
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Integrace
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Word 2010: Backstage

Tips for a New Hire - Microsoft Word
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Word 2010: Co-Authoring

IE- H’ | Tips for a Mew Hire - Microsoft Word o B OER
Home Insert Page Layout References Mailings Review View 3 O

A 34 Find ~
AaBbCcDe  AaBbCcDc ’7&*
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- j - 7| Styles * Ly Select ~

Clipboard Paragraph Styles Editing

Toni Poe B

Contoso

Toni Poe B On the Insert tab, the galleries include items that are designed
to coordinate with the overall look of your document. You can
use these galleries to insert tables, headers, footers, lists, cover
pages, and other document building blocks. When you create
pictures, charts, or diagrams, they also coordinate with your
current document look. You can easily change the formatting of ‘ L j
selected text in the document text by choosing a look for the
selected text from the Quick Styles gallery on the Home tab. You can also format text directly by using
the other controls on the Home tab.

Toni Poe B - You can use these galleries to insert tables, headers, footers, lists, cover pages, and other document
building blocks. When you create pictures, charts, or diagrams, they also coordinate with your current
document look. You can easily change the formatting of selected text in the document text by choosing
a look for the selected text from the Quick Styles gallery on the Home tab. You can also format text
directly by using the other controls on the Home tab. Most controls offer a choice of using the look from

Auth(l)rs editing thlis documenlg g a format thht you specify directly.

T of your document, choose new Theme elements on the Page Layout tab. To
in the Quick Style gallery, use the Change Current Quick Style Set command.

nd the Quick Styles gallery provide reset commands so that you can always

ocumentto the original contained in your currenttemplate. Onthe Inserttab,

Page:1 of 9 | Words: 5,031 | gz |"'K | NEIGERES
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Spolupracujte s lidmi a obsahem - kdekoliv

Cteni a zapis napric vice zarizenimi se SharePoint a Office

JUNIPER»

JUNIPER»

- e i —— B

Pre-Beta screenshots, subject to change

% | Intem

Editace

Mobilni
pristup

Office Apps

1 | Blends | Red Blac Green
Label | Label | Label

Docs
g Ofce Moble7UX 1y
Amy Alberts
M2 readiness reviews
1 SharePoint Mobile

[ One Page Specs
[ PPT feature list
i, Release Document

Knihovny
SharePoint




Exchange Server 2010

Emalily, kalendare (sdilené), ukoly, kontakty, hlasova posta, logy
volani

Vysoka dostupnost, zabezpeceni i vykon, transportni pravidla,
politiky uchovavani...
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Office Communications Server 2007 R2

Telefonovani, IM, audio a video hovory, hromadné video
konference, sledovani prezence uzivatelU

Integrace v ramci celého baliku aplikaci Office 2010

Klientsky software — Office Communicator, Office Live Meeting 2007, Outlook

= Denisa Houdkova

E] zékaznicka prezentace

PREZENTACE USPOR
DOSAZENE DIKY

SJEDNOCENE KOMUNIKACI




Moznost pristupu odkudkoli
Priistyenkey zpédivém ¢d3€ zmahiiychazzéiizen seetycamgbu

rozhranim

PC »

fle £t Go Took Adions Conferencing Hep

3 Schedyle a Conference Cal

Voice Mail from Pat Coleman (29 seconds)

n behalf of # Pat Coleman

You received a voice mail from Pat Coleman at

d:

<4

roenas

Project Team A

4 Research

L William Lyor

Other Contacts

Mobil P

.'.' Outlook E-mail o 7, % X

Urgent: Customer Yist
Ian Hameroff

7= Location? AmneSiacs Ahoh

@ Sales Meeting, New York?
Adam Jung

{4 Contoso Biz. Plan Proposal

Jim Lucey

{w» Voice Mail from Brandon
Brandon Hoff (EXCHANGE)
Adam can you meet at 130,

Outlook E-mail 22 Items, 21 Unr

Delete B Menu

1} Gutlook Web Ac

+ =

Veice Mail from Brandon Hoff (EXCHANGE)

aa

Andy Jacobs [8:22 AM]:

*sure

*let me share my desktop




Sjednocena komunikace — vyuziti na
univerzitach

Snazsi a rychlejsi komunikace s
kolegy/externisty/studenty

Prizvani hostu do vyuky pres video
konferenci

Vzdalena vyuka - napr. dalkoveé studium

Snizeni nakladu na skoleni

— Nahrana skoleni si kazdy zameéstnanec muze/musi
prehrat

— Skoleni je mozno provadet 1x a to z jednoho mista
pro vsechny

Omezeni nakladu na interni telefonovani



Microsoft Online Services

Serverove reseni komunikace a spoluprace hostovane
Microsoftem nebo partnery

Business Productivity Online Suite




Integrované moznosti

Bezproblemova komunikace v ramci aplikaci a zarizeni

E-mail :
Instant Messaging Web Conferencing
Sdileni dokumentu Prezence

Kalendar o
Work Flow Mobilita Offline pFistup Archivace

Shared Documents

Share a document with the team by adding it to this document library.
Recent Contacts

-y ) & -
New ~ Upload ~ | Actions'~ L X ) Buddics
[ TR : 3 Mail ccs
= Edit in Datasheet e €CS Infrastructure

ere are no items to shov Lz_l i 3 = & Sharma
4 calendar
8= Contacts
Connect to Outlook 2 Deleted Items

Synchronize items and make them ”
available offine, : _.#| Drafts [2]

Arrange By: Date

U] Inbox (4) Last Month

[ @ Junk E-Mai
flo NUT" == | JesseVilla
T 'Y ores FW: draft mail Get assistance or provide fe

View RSS Feed : '-Zi Outbox and UC Phones
B Zi ® [ RSS Feeds

L= Sent Items = JesseVilla
H [ Sync Issues FW E

Export to Spreadsheet

Olde
Alert Me




Prehled vlastnosti

5GB (vychozi) az do 25GB mailbox 250MB datovy prostor pro uzivatele
Outlook klient i webovy pfistup Spoluprace uzivatelu
Anti-Virus/Anti-Spam Portal :

Sdilené kalendare, kontakty & tkoly Enterprise Content Management

Active Sync pro mobilni zafizeni Pokrocile vyhledavani
Podpora Blackberry zafizeni* Business Process Formulare

Archivace* Platforma + rozsifitelnost

Weboveé konference Instant Messaging a prezence
Jak pro spolup. malych skupin, tak pro velké udalosti Skupinové IM

Sdileni plochy, chat, dotazy a odpovédi Prohledavani adresare kontaktl
Podpora VOIP nebo PSTN hlasu Pfenos soubort

360 stupnové panoramatickeé video 1:1 audio a video

* \olitelné vlastnosti za poplatek




Umisteni datovych center

Ireland

. Netherlands China

. - Europe g ...
Washington .North America P

@ viginia India @ +ong kong

California e \ e ‘ ,
?xas e’uerto Rico Afrl Ca ‘ smgaporé

Central and Australia
South America

@ Stavajici centra

@ Pripravovana centra



Microsoft Live@Edu

* Sada sluzeb na platforme Windows Live pro vysokeée
skoly (studenty)

* Zachovani domeény a grafického stylu skolni
Instituce

* Prevzeti nakladu spojenych se spravou
studentskeho e-mailu a vyuziti moderni

infrastruktury datovych center spolecnosti
Microsoft

° Vsechny sluzby dostupné z jednoho mista
http://home.live.com



http://home.live.com/

Microsoft Live@Edu

Komunikace
Sdileni

Pristup odkudkoliv
Bezpecnost

Inovativni nastroje, které
Jsou obecné znamé a
funguji bezproblemové

napfi¢ Internetem a
raznymi typy zafizeni

Kalendar

Mail

Soubory Kontakty
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X

Skupiny BezpecCnost

Socialni sité







